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    Administra a Ideias & Ideias Comunicações, ministra treinamentos em instituições como Senac, ABTG e DRC em São Paulo, dos temas: Produção Gráfica, Producão Gráfica para Vendedores, InDesign, Illustrator, CorelDRAW, Photoshop, Preps e Geração de Livros Digitais no formato ePub. É colaboradora das revistas Publish da Dabra Editora e da Tecnologia Gráfica da ABTG.
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    Prefácio


    Diagramar é distribuir textos e imagens em uma página de forma equilibrada, respeitando os anseios do leitor e tornando sua leitura agradável e interessante.


    Os aplicativos de layout de página estão cada vez mais sofisticados quanto à disponibilidade de recursos destinados para esse fim.


    O InDesign na versão CS6, possui novidades na parte referente ao layout, tornando a interação com o usuário no momento da manipulação das ferramentas e dos comandos, muito mais simples e intuitiva.


    Ele permite que os esforços estejam concentrados na montagem das páginas, seus conteúdos e na importância de cada elemento.


    Desta forma, a criatividade não será limitada pelos recursos ou pela falta de interação do usuário com o programa.


    Convidamos você a conhecer mais sobre o InDesign CS6, utilizar seus recursos disponíveis e tornar seus projetos cada vez mais sofisticados.


    Os autores

  


  
    Sobre este livro


    Este livro tem como objetivo explicar os recursos do Adobe InDesign e como ele pode ajudar especificamente os profissionais da indústria gráfica – designers e funcionários de birôs, gráficas e editoras – de maneira geral a produzir, diagramar, editar, arte-finalizar e gerar arquivos PDF, com mais eficiência, para a produção de impressos comerciais, promocionais e editoriais.


    Ele foi estruturado de forma didática, para que o leitor, independente do seu nível de informação nos processos e aplicativos de editoração eletrônica, possa aprender ou atualizar seus conhecimentos.


    Os recursos e comandos foram agrupados em capítulos que acompanham o processo de diagramação, arte-finalização e geração de PDFs.


    O conteúdo do livro foi dividido em vários volumes sendo que o primeiro trata dos recursos de layout e diagramação; o segundo dos recursos de edição e formatação de textos; o terceiro dos recursos de automação e produtividade; e o quarto dos cuidados com a arte-finalização, preflight e geração dos arquivos PDF.


    Para facilitar o aprendizado, existem vários exemplos práticos passo-a-passo e os procedimentos são ilustrados com as capturs de telas do aplicativo.


    Além disso, existem dezenas de valiosas dicas, truques, e principalmente avisos, recomendações espalhadas pelos capítulos e volumes.


    Os autores procuraram inserir neste material boa parte da sua experiência na construção de arquivos para Desktop Publishing, de maneira a minimizar e até eliminar os problemas na fase de pré-impressão, impressão convencional ou digital, assim como todas as formas para evitar e resolver os “pepinos e abacaxis” que porventura possam aparecer.


    As sugestões, recomendações de configurações e ajustes nas opções, comandos e recursos foram meticulosamente estudadas para a realidade de quem precisa obter fotolitos ou chapas de impressão offset, ou mesmo impressos a partir das modernas e tão exigentes quanto, impressoras digitais comerciais.

  


  
    Como utilizar esta coleção de livros


    Para melhor compreensão do modus operandi do Adobe InDesign e os recursos, o conteúdo da coleção foi dividido em volumes e capítulos cujos nomes definem de forma clara os assuntos tratados.


    Isso permite ao leitor que quer aprender ou está enfrentando algum problema específico, ou mesmo possui alguma dúvida, ir diretamente para o volume e o capítulo que trata do assunto.


    A coleção foi projetada para que os capítulos sejam completos e independentes, mas, ao mesmo tempo, que a obra possa ser lida sequencialmente, o que é recomendável, sobretudo em relação aos primeiros volumes e capítulos.


    Parte I - Layout & Diagramação


    Esta parte trata dos recursos básicos de operação do InDesign tais como ferramentas, frames, edição de elementos de página, trabalho com paths, importação de elementos externos, gerenciamento de vínculos e paginação.


    Parte II - Textos


    A segunda parte deste livro trata dos recursos de edição e formatação de textos tais como importação, seleção, atributos de caracter, de parágrafo, correção ortográfica, além de explicar o processo de confecção e importação de tabelas.


    Parte III - Automação de Tarefas & Produtividade


    A terceira parte deste livro trata dos recursos de automação de tarefas e de produtividade do InDesign tais como estilos de parágrafo, caracter, objetos e tabelas, Book, confecção de sumários, índices remissivos, textos variáveis e condicionais, referências cruzadas, notas de rodapé etc. O destaque são os novos recursos de revisão baseados no Acrobat.com.


    Parte IV - Arte-Final, Preflight e Geração de PDFs


    A quarta parte deste livro trata dos cuidados com a arte-finalização de projetos gráficos, com as fontes tipográficas, cores e preenchimentos, além de explicar os recursos de preflight visual e eletrônico. O destaque desta parte é o capítulo que mostra passo-a-passo os processos mais confiáveis para geração de arquivos PDF para envio para empresas gráficas.


    Convenções usadas


    A seguir serão detalhadas algumas convenções usadas nessa coleção de livros.


    O Adobe InDesign


    O Adobe InDesign CS6 é comercializado isoladamente, mas também está inserido em vários pacotes Adobe Creative Suite:


    
      	Adobe Creative Suite Design Premium CS6.


      	Adobe Creative Master Collection CS6.

    


    O Adobe InCopy


    O Adobe InCopy CS6 somente é comercializado isoladamente.


    Sistemas operacionais usados


    Para a confecção deste livro nos baseamos no Windows XP com Service Pack 2, Windows 7 e o Mac OS X (10.5.8).


    O InDesign com raríssimas exceções é virtualmente idêntico nas duas plataformas. Quando houver diferenças, elas serão devidamente destacadas.


    Ícones


    Mesmo usuários experientes podem desconhecer e deixar escapar pequenos e grandes recursos ou armadilhas escondidas nos aplicativos do pacote ou mesmo, descobrir novas formas de se realizar tarefas. Por isso identificamos estas dicas e armadilhas com um ícone.


    As novidades referentes a versão CS6, as referências cruzadas e as sugestões de uso dos comandos e ferramentas também serão indicados com ícones durante o processo de aprendizado e leitura do livro.


    [image: Veja.pdf]Os parágrafos indicados com o ícone “Fique de Olho” são lembretes de utilização do aplicativo e/ou formas alternativas de se realizar uma mesma tarefa. Podem também identificar processos que originam resultados indesejados ou que requerem uma atenção especial, pois o uso de um determinado comando, opção ou configuração oferece risco de problemas sérios com consequências onerosas.


    [image: Referencia.pdf]O ícone “Saiba Mais” identifica referências cruzadas e outros tópicos relacionados com o assunto que está sendo estudado. Caso você queira se aprofundar, será indicado o capítulo, página e volume para continuar sua pesquisa.


    [image: Novidade_CS6.pdf]A “Coleção Adobe InDesign CS6” contempla as principais alterações realizadas na versão CS6. Por isso, caso você queira verificar somente o que é novo na versão, o ícone “Novidade” indicará os recursos que sofreram alterações e foram colocados próximo aos assuntos correlatos.


    [image: Experimento.pdf]No final dos principais capítulos, existe uma proposta de experimentação dos comandos estudados, que são indicados pelo ícone “Faça um Experimento”, convidando você a testar os conhecimentos adquiridos.
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    01 | OPERAÇÕES BÁSICAS


    01.1 | Criação e manipulação de páginas


    A página é a base de qualquer projeto gráfico impresso e a determinação das características desse item está relacionada com vários aspectos do projeto como formato, número de colunas, área de impressão (mancha), entre outros.


    01.1.1 | Manipulação de páginas - procedimentos básicos


    A primeira ação para se iniciar o processo de diagramação é a configuração da estrutura das páginas. À medida que a publicação se desenvolver, será acompanhada por uma paleta de gerenciamento de páginas que permite inserir, apagar e modificar o ordenamento entre elas.


    01.1.2 | Manipulação de páginas - procedimentos passo-a-passo


    1. Crie uma ou mais páginas de um documento novo com o do comando Document no menu File > New.


    [image: New_01.jpg]


    2. Defina as configurações relacionadas com o seu projeto gráfico seguindo as descrições do quadro de diálogo.


    Document Presets: Estilos de publicações criados previamente.


    [image: Pages_01.jpg]


    [image: Veja.pdf]Os estilos de publicação podem ser criados por meio do comando Define, no menu File > Document Presets. Os estilos existentes serão listados na janela e poderão ser editados através do botão Edit. Para a criação de um novo estilo, o botão utilizado será o New. Existe ainda a opção de importar estilos de publicações que estão salvos em diretórios/pastas específicos, por meio do botão Load.


    [image: New_02.jpg]


    [image: Novidade_CS6.pdf]_____________________


    [image: new_novo1.jpg]


    Intent: Determina se a publicação será dirigida para mídia impressa (Print) ou para Internet (Web) ou para publicação (Digital Publishing).


    [image: new_novo3.jpg]


    Está opção está disponível também em Document Setup, no menu File.


    Number of Pages: Quantidade de páginas da publicação. Pode ser alterado posteriormente ao se incluir ou excluir páginas a qualquer momento da diagramação.


    Facing Pages: Permite que as margens sejam tratadas como interna/externa para publicações com acabamento na lombada (livro, revista) ou como direita/esquerda se o acabamento for refile simples (folheto, mala direta, cartaz).


    Start Page #: Determina qual a numeração da primeira página do documento.


    [image: Novidade_CS6.pdf]_______________


    Primary Text Frame: Permite criar um frame na página mestre que será referência todas as vezes que uma nova página mestre for aplicada.


    Para acionar este comando clique Primary Text Frame, quando for criar um novo documento com o comando New, do menu File. Atente para o fato de desligar a opção Facing Pages, porque este comando não trabalha com páginas duplas.


    Note que a página de trabalho já possui um frame de texto aplicado e que tem um ícone que aparece do lado superior esquerdo do frame, indicando a existência do recurso.


    [image: new_novo5.jpg]


    Coloque texto no frame da página que está sendo diagramada.


    [image: new_novo6.jpg]


    Crie uma nova página mestre e coloque um frame de texto com características diferentes da primiera página mestre. Neste caso, também aparece um ícone na parte superior esquerda porém indicando somente que o recurso estudado está disponível.


    [image: new_novo7.jpg]


    Para acionar o frame de texto primário, clique uma vez sobre o ícone.


    [image: new_novo8.jpg]


    Aplique a nova página mestre a primeira página do layout. Note que o texto fui naturalmente para o novo formato de frame.


    Se hover excesso de texto resultante da adequação ao novo layout, o programa abre uma nova página e distribui o resto de texto.


    É possível aplicar páginas mestres com formatos diferentes de frame nas páginas da publicação e o texto irá fluir automaticamente entre eles.


    [image: new_novo9.jpg]


    _______________


    Page Size: Exibe uma lista de formatos. A opção Custom aparece quando se configura um formato que não está disponível na lista.


    Width/Height: Exibe as medidas de largura e altura do formato de página pré-definido e permite a digitação de valores para formatos personalizados.


    Orientation: Posição vertical (portrait) e horizontal (landscape) da página.


    Columns: Número de colunas (Number) e espaço entre elas (Gutter). Durante o desenvolvimento da diagramação da publicação estas opções podem ser alteradas.


    Margins: Determinam a área de mancha da publicação. Dependendo da opção Facing Pages (ligada / desligada) pode-se ter como resultado Left / Right (esquerda / direita) ou Inside / Outside (interna / externa) nas margens laterais da página.


    Do lado direito da tela, existe um botão entitulado More Options, que abre mais opções para o comando New.


    Bleed: Determina a área de sangria. Dependendo do tipo de acabamento, é necessário colocar valores diferentes para cada lado da sangria. Se os valores forem iguais, basta digitá-lo em um dos campos e clicar no ícone da corrente que o programa duplicará o valor digitado nos demais campos.


    [image: Veja.pdf]Essa opção deve ser acionada também no momento da impressão no comando Print ou na exportação para PDF no comando Export, disponíveis no menu File, possibilitando a reprodução da sangria.


    Slug: Determina a área do pasteboard que pode conter informações que se queira imprimir, como marcas de dobra, logotipos ou informações adicionais.


    [image: Veja.pdf]Essa opção deve ser acionada também no momento da impressão no comando Print ou na exportação para PDF no comando Export, disponíveis no menu File, possibilitando a reprodução da sangria.


    [image: Veja.pdf]Altere as especificações de página, com exceção da opção Master Page Frame, durante o processo de diagramação, utilizando Document Setup, localizado no menu File.


    [image: New_03.jpg]


    [image: Veja.pdf]Altere as configurações de margem no comando Margins and Columns disponível no menu Layout.


    [image: pages.tif]


    3. Gerencie as páginas pela paleta Pages, que fica posicionada do lado direito da tela. Caso ela não esteja disponível, clique em Page, no menu Window. Pela paleta é possível deslocar, inserir e excluir páginas visualmente.


    [image: Pages_03.jpg]


    4. Note que o ícone de alteração de formato de página disponibiliza um submenu que lista vários formatos. A opção Custom Page Size permite personalizar o formato da publicação.


    01.2 | Rotação de páginas


    As páginas podem ser rotacionadas para facilitar o trabalho de diagramação de projetos que precisam estar posicionados em orientações diferentes. Por exemplo, uma página na vertical, mas com uma tabela que o leitor deve deixar a página na horizontal para ler.


    1. Escolha a página selecionando-a na paleta Pages.


    2. Acesse o submenu da paleta, escolha Rotate Spread View e clique no ângulo de rotação. As opções são: 90º CW (sentido horário), 90º CCW (sentido anti-horário) e 180º.


    [image: Rotate_Spread_01.jpg]


    3. Note que na paleta ao lado da página selecionada, exibe uma indicação da rotação, mesmo que a miniatura continue na vertical, no caso do exemplo.


    [image: Rotate_Spread_02.jpg]


    4. No layout é possível visualizar a página rotacionada. Atente para o fato de que a rotação da página será apenas operacional. Ao fechar o arquivo, a página fica na posição original.


    5. Se houver necessidade de rotacionar a página no resultado final, utilize a opção de formatos diferentes.


    [image: Rotate_Spread_03.jpg]


    [image: Referencia.pdf] Veja mais informações sobre esse assunto em “Páginas de formatos diferentes”, desse volume.


    01.3 | Aplique cores nas páginas


    É possível aplicar cores nas miniaturas dentro da paleta Pages para facilitar a organização das páginas.


    Basta escolher as cores disponíveis no comando Colour Label localizado no submenu da paleta Pages.


    As páginas não ficam coloridas na impressão.


    [image: Cor_pagina.jpg]


    1. A paleta Pages também possui um submenu que permite dar acesso a outros comandos relacionados com atributos de controles de página. Alguns comandos relacionados a manipulação de página também podem ser acessados pelo menu Layout > Pages.


    2. Utilize o comando Insert Pages para inserir páginas na publicação, especificando a localização dessas páginas, antes ou depois da página de referência. Escolha também qual a página-mestre que estará sendo vinculada à estas novas páginas.


    [image: Pages_04.jpg]


    [image: Veja.pdf]Para manter as páginas espelhadas sempre juntas, selecione as páginas em questão e desmarque a opção Allow Selected Spread to Shuffle no submenu da paleta Pages. Estas páginas serão identificadas por um colchete ao redor no número na visualização da paleta.


    [image: Pages_05.jpg]


    [image: Veja.pdf]As páginas geralmente são espelhadas em duplas, porém em determinados projetos será necessário criar páginas espelhadas com três ou mais páginas. Para que essa ação seja possível é preciso desmarcar a opção Allow Document Pages to Shuffle, no submenu da paleta Pages. Com o mouse é possível posicionar as páginas conforme a diagramação desejada na paleta Pages.


    [image: Pages_06.jpg]


    01.4 | Páginas de formatos diferentes


    O InDesign CS6 permite a existência de páginas com diferentes dimensões e orientações de páginas em um mesmo documento.


    Selecione a página a ser alterada e clique no ícone [image: Multiplas_paginas_01.jpg] posicionado na parte inferior da paleta Pages.


    [image: Multiplas_paginas_02.jpg]


    Aparecerá um submenu com opções de formatos, incluindo a Custom Page Size que abre a possibilidade de personalização por meio de um quadro de diálogo.


    [image: Multiplas_paginas_03.jpg]


    É possível escolher um formato personalizado e mudar a orientação da página, bem como nomear essa opção para que fique disponível sempre que o ícone [image: Multiplas_paginas_01.jpg] for acessado.


    [image: Multiplas_paginas_04.jpg]


    A alteração do formato e orientação, podem ser visualizados na própria tela do InDesign e nas miniaturas da paleta Pages.


    01.5 | Páginas-mestre


    Um dos mais interessantes recursos de automação em aplicativos paginadores são as páginas-mestre.


    Essas páginas permitem que o usuário crie um padrão utilizando elementos que são comuns a todas as páginas da publicação, como cabeçalhos, rodapés, números de página ou quaisquer elementos que façam parte do projeto gráfico e que aparecem em várias páginas na mesma posição.


    01.5.1 | Páginas-mestre - procedimentos básicos


    A criação da página-mestre está relacionada com o diagrama base, e deve ser norteado pelo projeto gráfico visando manter as características das páginas sempre iguais e ao mesmo proporcionando automação em algumas tarefas relacionadas com esses itens, como a numeração de página, por exemplo.


    As alterações nas páginas-mestre podem ocorrer a qualquer momento do processo de diagramação.


    01.5.2 | Páginas-mestre - procedimentos passo-a-passo


    1. Determine a quantidade e as características que as páginas-mestre devem possuir segundo o seu projeto gráfico.


    2. Para criar uma página-mestre nova utilize o comando New Master, no submenu da paleta Pages.


    [image: Pages_07.jpg]


    3. Nomeie as novas páginas-mestre na opção Name, escolha se a nova página-mestre é derivada de uma outra existente, no campo Based on Master, além de escolher a quantidade de página em Number of Pages. A nova página-mestre estará disponível na paleta Pages.


    [image: Veja.pdf]Para vincular uma página da publicação com uma nova página-mestre é necessário clicar na página-mestre e arrastá-la até a página desejada. Se preferir, pode-se utilizar o comando Apply Master to Page no submenu da paleta Pages, escolher a mestre a ser aplicada e as páginas que deverão ser modificadas.


    4. Escolha o modo como a numeração de página deve aparecer na publicação, que deve ser colocada na página-mestre, para servir de referência à todas as páginas da publicação. Essa numeração independe da variedade de páginas-mestre da publicação.


    [image: Veja.pdf]Ao adicionar uma nova página à publicação, o InDesign se encarregará de alterar a numeração de todas as páginas seguintes para respeitar a sequência numérica da publicação, mesmo que existam páginas que não serão numeradas, ou seja, com a impressão do número de página.


    01.6 | Numeração automática


    1. Para utilizar o recurso de numeração automática é necessário clicar em uma página-mestre, adicionar um frame de texto, e com a ferramenta de texto, escolher o comando Current Page Number, no menu Type > Insert Special Character > Markers.


    [image: Numeracao_auto_01.tif]


    2. A visualização da numeração é o prefixo utilizado para nomear a página-mestre. Nela, esse texto é igual a qualquer outro, por isso pode ser formatado com todos os recursos disponíveis, tais como fonte, tamanho e alinhamento. Nas páginas comuns, a numeração aparecerá conforme essas formatações.


    [image: Numeracao_auto_02.tif]


    3. Altere se necessário, as configurações dos números da numeração de página, o início de numeração ou inclusão de seção por meio do comando Numbering & Section Options, localizado no submenu da paleta Pages, conforme as descrições a seguir.


    [image: Pages_08.jpg]


    Start Section: Determina o uso de seção na publicação.


    Automatic Page Numbering: Faz a numeração automática seguindo as posições das páginas na paleta Pages.


    Start Page Numbering at: Determina qual o número em que começará a numeração.


    Page Numbering


    Section Prefix: Inclui um prefixo para a seção, que pode ser caracter ou espaço, contendo até 8 caracteres. Por exemplo, “A 16” ou “A - 16”.


    [image: Veja.pdf]Não é possível inserir um espaço em branco pressionando a barra de espaço. Em vez disso, copie e cole um caracter de espaço de largura fixa da janela do documento. Observe que sinais de adição (+) e vírgulas (,) não podem ser usados sem prefixos de seção.


    Style: Tipo de numeração, por exemplo arábico ou romano.


    Section Marker: Caracter inserido na página, no local de um caracter marcador de seção que é exibido quando você escolhe o comando Section Marker no menu Type > Insert Especial Caracter > Markers.


    Include Prefix when Numbering Pages: Se estiver marcado os prefixos de seção serão impressos ou gerados no sumário e no índice.


    Document Chapter Numbering: Coloca numeração automática nos capítulos da publicação.


    Style: Especifica o tipo de numeração dos capítulos.


    Automatic Chapter Numbering: Coloca a numeração de capítulos de forma sequencial.


    Start Chapter Numbering at: Determina qual o número em que começara a numeração dos capítulos.


    Same as Previous Document in the Book: Utiliza o mesmo número de capítulo do documento anterior de um Book. Essa opção só é válida no caso do documento atual fazer parte do mesmo capítulo do documento anterior em um Book.


    Book Name: Se o arquivo em que está trabalhando faz parte de um Book, o seu nome aparecerá nessa opção.


    01.7 | Visualização


    01.7.1 | Zoom


    A aplicação de diferentes visualizações por meio de aplicação de fatores de zoom é fundamental para que possamos ter uma visão mais aproximada dos elementos que estamos manipulando ou para ter uma visualização geral da página.


    [image: zoom.tif]


    O InDesign possui a ferramenta de zoom posicionada na barra de ferramentas e que disponibiliza a ampliação e redução em incrementos de 25%. Para ampliar, utilize a ferramenta na área em que se deseja aumentar a visualização, para reduzir pressione a tecla Alt/Option e depois clique com a ferramenta.


    A ferramenta Hand Tool permite ajustar o posicionamento pelo cursor do mouse que se transforma em uma mãozinha.


    [image: Veja.pdf]Para facilitar é possível utilizar teclas de atalho. O Command/Control + 0 (zero) encaixa a página na tela, Command/Control + (sinal de mais) amplia, e Command/Control - (sinal de menos) diminui.


    [image: Veja.pdf]Para acessar a ampliação setorial experimente clicar e segura o mouse enquanto pressiona a tecla Alt/Option.


    Se preferir, digite o fator de zoom na barra de propriedades, localizada na parte superior da tela.


    [image: Zoom_01.jpg]


    Existem várias opções de zoom disponíveis no menu View. Com destaque para Entire Pasteboard que visualiza além da página, a área ao redor dela (pasteboard).


    [image: Zoom_02.jpg]


    01.7.2 | Modos de visualização


    Existem várias formas de visualização dos layouts dentro do InDesign, que permite ver como será a aparência do projeto no final, utilizando ou não sangria (bleed) e deslocamento (slug).


    01.7.3 | Modos de visualização - procedimentos passo-a-passo


    1. Abra um arquivo diagramado que possua sangria e deslocamento.


    2. Escolha a opção Normal na última ferramenta da barra.


    [image: Visualizacao_01.jpg]


    3. Veja que todas as linhas de construção dos frames e as guias estão aparecendo.


    [image: Visualizacao_02.jpg]


    4. Troque para a opção Preview. Observe que o layout aparece da maneira como será quando for impresso.


    [image: Visualizacao_03.jpg]


    5. Alterne agora para a opção Bleed. É possível ver o resultado final do layout só que com a sangria.


    [image: Visualizacao_04.jpg]


    6. Mude para o modo Slug e veja que aparece, além da sangria, a área de pasteboard que será impressa.


    [image: Visualizacao_05.jpg]


    7. E, por fim, veja o modo Presentation. Essa é uma das opções de visualização das páginas como se fosse uma apresentação de slides.


    [image: Visualizacao_06.jpg]


    01.7.3.1 | Criação de apresentações


    [image: Presentation.jpg]


    Os arquivos de InDesign podem ser transformados em apresentações utilizando o modo de visualização Presentation.


    A movimentação dos slides (páginas) pode ser feita usando as teclas de setas ou com o clique do mouse.


    A seguir algumas teclas e suas funções durante o modo de visualização Presentation:


    
      	
Esc: Sair do Modo Presentation.


      	
Home: Primeiro slide.


      	
End: Último slide.

    


    01.7.3.2 | Visualização de imagens no modo Preview


    [image: Preview.jpg]


    A visualização da imagem, que está fora da prismagem do frame, pode ser visualizada também no modo Preview, incluindo o uso do Indicador de Conteúdo (círculo no centro do frame).


    01.8 | Ajuste de layouts


    O recurso ajuste de layout possibilita rediagramar automaticamente os elementos quando existe alguma alteração de tamanho ou orientação da página, assim como na quantidade de colunas e especificações das margens.


    [image: Ajuste_Layout_02.jpg] [image: Ajuste_Layout_03.jpg]


    Escolha o comando Layout Adjustment localizado no menu Layout.


    [image: Ajuste_Layout.jpg]


    Enable Layout Adjustment: Habilita o recurso e o acesso às opções disponíveis.


    Snap Zone: Margem de limite para o ajuste automático entre os elementos e as linhas-guia, colunas e margens da página.


    Allow Graphics and Groups to Resize: Determina que as imagens e os grupos de frames podem ser redimensionados durante o ajuste automático.


    Allow Ruler Guides to Move: Reposiciona as guias de referência no novo layout.


    Ignore Ruler Guide Alignments: Ignora os alinhamentos dos elementos relacionados às linhas-guia.


    Ignore Object and Layer Locks: Ignora elementos em camadas travadas.


    [image: Veja.pdf]A mudança automática de layout será mais precisa se os elementos estiverem alinhados por guias e colunas configuradas no programa, criadas pelo comando Margin and Columns, localizado no menu Layout.


    [image: Veja.pdf]O recurso auxilia bastante, mas dificilmente fará um trabalho perfeito. Portanto é recomendável uma revisão atenta em todas as páginas do documento.


    [image: Novidade_CS6.pdf]_______________


    No momento da criação das páginas de uma publicação é bastante comum a experimentação de diferentes formatos e redimensionamento dos elementos.


    O InDesign possui um conceito de transformação de layout de forma simples e com visualização rápida, chamado de Layout Líquido (Liquid Layout).


    Para usar o recurso é preciso ter uma página da publicação já diagramada.


    Com a ferramenta [image: Icones_Ferramentas.tif] Page, selecione a página. Note que aparecem controles nas laterais que permitem a edição. A visualização é em tempo real e se quiser manter a alteração, utilize a tecla Options (Mac Os) ou Alt (Windows) precionada enquanto edita.


    [image: layout_liquid.jpg]


    O modo como o layout é modificado pode ser configurado por meio dos comandos que aparecem na barra de propriedades.


    [image: liquidy_layout_05.jpg]


    Off: Desligado.


    Scale: Altera o tamanho.


    Re-center: Os elementos não sofrem alteração mas são aplicados sempre no centro da página.


    Object-based: Define se a largura ou a altura do objeto deve mudar, além de permitir definir os espaços entre o lado do objeto e os lados da página. Após a seleção da página, selecione o elemento desejado. Note que existe um ícone de um cadeado no meio do elemento que determina que o objeto está travado. Se quiser destravar clique duas vezes sobre este ícone.


    [image: liquidy_layout_03.jpg]


    Guide-based: Utiliza guias para definir se a largura de um objeto ou a altura deve mudar. A posição das guias determinam como os objetos são afetados.


    Controlled by Master: Utiliza qualquer configuração que foi aplicada a página mestre.


    A paleta Liquid Layout possui configurações específicas sobre os modos disponíveis de edição de layout. Para acessá-la utilize o menu Layout, comando Liquid Layout.


    [image: liquidy_layout_04.jpg]


    _______________


    01.9 | Modelos (templates)


    Na editoração de publicações periódicas é bastante comum utilizar o arquivo da edição anterior e diagramar por cima a próxima edição.


    Porém, como cada edição é peculiar, e é muito fácil fazer pequenos ajustes, como mudanças sutis no projeto gráfico, é comum que haja, aos poucos, um distanciamento entre o projeto original e o atual, principalmente se a publicação for diagramada por uma equipe de pessoas com modos de trabalho diferentes.


    Para evitar que isso aconteça é interessante criar um documento com as características do projeto gráfico, contendo estilos, bibliotecas de cores, páginas-mestre, entre outras configurações gerais.


    Nesse caso, o ideal é criar um template, gabarito ou modelo, usando um arquivo de InDesign que contém as padronizações do projeto, mas possui uma extensão diferente: .indt. (A extensão de documentos do InDesign é .indd).


    01.9.1 | Templates - procedimentos passo-a-passo


    1. Crie um arquivo com todas as características do seu projeto gráfico.


    2. Use o comando Save As do menu File. Escolha a opção InDesign CS6 template no campo Salvar como tipo.


    [image: Template.jpg]


    3. Agora abra esse arquivo. Note que o arquivo vem sem nome porque se trata de uma cópia do template.


    4. Faça as alterações necessárias e salve-o normalmente como uma publicação do InDesign.


    01.10 | Exportação para abertura em versões anteriores do InDesign CS6


    Para abrir os documentos criados no InDesign CS6 em versões anteriores do produto é necessário fazer a exportação dos arquivos por meio do comando Export do menu File e escolher a opção InDesign Markup (IDML) no campo Salvar como tipo.


    [image: Exportacao_IDML.tif]


    [image: Experimento.pdf] Crie um documento novo, configure-o com várias páginas e manipule-as com a paleta Pages. Faça várias páginas-mestre com opções diferentes de numeração. Insira e remova algumas páginas e observe como o InDesign gerencia essas ações. Experimente as formas de zoom e visualização. Salve sua publicação como um arquivo de documento e de template e veja as diferenças. Teste um ajuste automático de layout em um documento previamente diagramado.
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